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REALTOR®  DEADLINES - TAKE YOUR CE AND RENEW YOUR LICENSE!

TIP #28 Shop online safely
When shopping online, check out a

Website before entering your credit card
number or other personal information.

Enter this information only on secure
Web pages with addresses that start

with “https” and have a closed padlock
symbol at the bottom of the browser

window. These are signs that your
information will be encrypted or

scrambled,protecting it from hackers. 

CLICK HERE FOR VIDEO!

CLICK HERE FOR THE VIDEO!

It is June, which means summer is here, the market is moving, and someone somewhere is already saying,
“I’ll get my CE done later.” Let’s not be that someone. Click the link HERE for the full story and everything
you need to know about your 2026 requirement deadlines.

Also, if you haven’t seen the brilliant CE video from the RANW
Communications Committee member-Ryan Fulcer, staring Michael
Sewell, entitled “The CE Class that Never Happened”, click to the
right and take a look! It’s hilarious!

https://app.bombbomb.com/video/180e9f06-50b1-47da-9cfb-c6d1c3e11657
https://youtu.be/7XzTpNTBL6U?si=pELxIyrOC_PQCXQ3
https://app.bombbomb.com/video/180e9f06-50b1-47da-9cfb-c6d1c3e11657
https://youtu.be/RK02HMyQSGE?si=-xKkuSwhQ2xfHPds
https://ranw.org/member-services/continuing-education-renewing-your-license-and-other-requirements/


The redesigned application makes it
easier than ever to match your
experience with the roles that need you
most. Don’t wait—complete your 2027
Committee Application by June 24.
https://bit.ly/4feq8UX

NeighborWorks Green Bay believes that
strong communities are built when
neighbors, partners, and local
organizations invest together in people
and place. 

SPONSORSHIP
OPPORTUNITIES FOR
NEIGHBORWORKS

DIRECT GIVER: YOUR VOICE, YOUR
CHOICE, YOUR IMPACT

We invite you to join us in that shared
work through sponsorship
opportunities that support our mission
throughout the year. Click HERE to see
three meaningful ways to partner with
this amazing organization!

Government Affairs & RANW Foundation

The candidates you support today
shape housing policy tomorrow.
Many of the most important
housing and property rights
decisions happen locally—at town,
village, city and county boards.
That’s why the Direct Giver program
is so powerful. Unlike your
investment in RPAC, the Direct
Giver program gives you the choice
and control over how you support
candidates important to you. See
why your participation matters in
the 30-second video HERE! 

https://bit.ly/4feq8UX
https://ranwwebsite.azurewebsites.net/media/2712/2026-gnw-annual-celebration-hbe-sponsorship-letter-1.pdf?fbclid=IwY2xjawRvFkVleHRuA2FlbQIxMABicmlkETEzbVZNaDdwTTZtUmpRbjcyc3J0YwZhcHBfaWQQMjIyMDM5MTc4ODIwMDg5MgABHpNGIyu3taB3TSb9oivFQudPEnbU5W-7j8Pf60eR31NR76k0e65CbSIkoLue_aem_FO93fAYJy_zdcQoc1lOV_Q
https://ranwwebsite.azurewebsites.net/media/2712/2026-gnw-annual-celebration-hbe-sponsorship-letter-1.pdf?fbclid=IwY2xjawRvFkVleHRuA2FlbQIxMABicmlkETEzbVZNaDdwTTZtUmpRbjcyc3J0YwZhcHBfaWQQMjIyMDM5MTc4ODIwMDg5MgABHpNGIyu3taB3TSb9oivFQudPEnbU5W-7j8Pf60eR31NR76k0e65CbSIkoLue_aem_FO93fAYJy_zdcQoc1lOV_Q
https://ranwwebsite.azurewebsites.net/media/2712/2026-gnw-annual-celebration-hbe-sponsorship-letter-1.pdf?fbclid=IwY2xjawRvFkVleHRuA2FlbQIxMABicmlkETEzbVZNaDdwTTZtUmpRbjcyc3J0YwZhcHBfaWQQMjIyMDM5MTc4ODIwMDg5MgABHpNGIyu3taB3TSb9oivFQudPEnbU5W-7j8Pf60eR31NR76k0e65CbSIkoLue_aem_FO93fAYJy_zdcQoc1lOV_Q
https://youtu.be/IwhKQKboCvc?si=Tm4hO2DrbwiYLNke
https://youtu.be/IwhKQKboCvc?si=Tm4hO2DrbwiYLNke


Events & Education
2026 RANW MAKE-A-WISH FUNDRAISER

You can still get tickets to attend and
support the Make-A-Wish WI fundraiser on
June 11 ! Your ticket includes food, two
drinks and the game! Bring your wallet to
bid on raffle baskets and silent auctions!
We are here to grant wishes for sick local
kids!

thBIGGEST EVENT OF THE YEAR!BIGGEST EVENT OF THE YEAR!
YOU HAVE TO BE THERE!YOU HAVE TO BE THERE!

GET YOUR TICKETS HERE!

MAP OF THE TIMBER RATTLERS
STADIUM HERE (NEUROSCIENCE
GROUP FIELD - 2400 N CASALOMA DR,
APPLETON, WI 54913)

DAY OF THINGS TO KNOW HERE
ONE PAGE FLYER FOR DAY OF
THINGS TO KNOW

THIS IS A RAIN OR SHINE EVENT!

https://www.gofevo.com/event/Realtorsassociation26
https://www.milb.com/wisconsin/ballpark/seating-chart
https://www.google.com/search?sca_esv=ec0135bcbec233e7&rlz=1C1GCEU_enUS1091US1091&sxsrf=ANbL-n4XeDJ-At9hb_my9ISHSYVPFtDrIA:1780949596197&q=neuroscience&spell=1&sa=X&ved=2ahUKEwjc96yguviUAxX7NoYAHYggHHkQkeECKAB6BAgNEAE
https://ranwwebsite.azurewebsites.net/events-education/2026-timber-rattlers-make-a-wish-fundraiser/day-of-things-to-know/
https://ranwwebsite.azurewebsites.net/media/2739/ranw-make-a-wish-fundraiser-things-to-know.pdf
https://ranwwebsite.azurewebsites.net/media/2739/ranw-make-a-wish-fundraiser-things-to-know.pdf


Wednesday, June 17th
1:30 pm– 4:00 pm snacks and drinks to follow
Hilton Paper Valley Hotel, Appleton
Register here: https://givebutter.com/AWREPNEWisconsin
Seats are limited, and this event will fill quickly.
Come with an open heart.
Leave with a renewed sense of purpose.

This event may change the way you serve
Veterans forever. Our affiliate member,
Linda WIlliamson is hosting an educational
event designed for REALTORS, title agents,
insurance agents, home inspectors, home
warranty companies, financial planners,
and really any professional who wants to
better bridge the gap between civilian and
military life.  

This is more than a business event.  It's a
chance to learn, connect, and show up
with greater respect, awareness, and care
for those you have served.  

Linda has dedicated a portion of each loan
she writes this year to award a local
Veteran with his/her own service dog!!  
We'll end the event with this surprise!  

HELP THE AMERICAN WARRIOR INITIATIVE FIND VETERANS SERVICE
DOGS

When REALTORS®, affiliates, brokers, lenders, inspectors, and industry partners come together,
amazing things happen. We can compete in the marketplace and still support each other as

professionals. At the end of the day, we're all working toward the same goal: stronger communities,
better service, and a thriving industry. 

We're not just colleagues. We're a community. ❤️ 
Contact Carey Martin, Heather Gossen or Justine Lamers with any questions.

When REALTORS®, affiliates, brokers, lenders, inspectors, and industry partners come together, amazing
things happen. We can compete in the marketplace and still support each other as professionals. At the end
of the day, we're all working toward the same goal: stronger communities, better service, and a thriving
industry. We're not just colleagues. We're a community. ❤️ 

CONTACT CAREY MARTIN, HEATHER GOSSEN OR JUSTINE LAMERS WITH ANY QUESTIONS.
#STRONGERTOGETHER #REALESTATECOMMUNITY 

https://givebutter.com/AWREPNEWisconsin


RANW SUMMER OF GOLF
Green Bay July 20 - SOLD OUT!
Fox Valley August 20 at High Cliff Golf Course
Oshkosh Sept 10 at Lake Breeze Golf Course

WCR SUMMER MASTERMIND
REGISTRATION HERE!!

Avoid the “PowerPoint fossil graveyard”.
We’ll make this feel like a live late-night
workshop where people accidentally learn
communication skills while laughing at
cursed Facebook graphics. 

HOW TO TALK GOODER ON THE
INTERNET 
THE ART OF NOT SOUNDING LIKE A
CORPORATE REFRIGERATOR 
THE PSYCHOLOGY OF WHY WE CLICK
WEIRD STUFF

Who doesn’t want to golf while technically at
work? Sign up for one or all three of our golf
events. You get 18 holes with a cart, lunch,
dinner, drinks, networking and fabulous
prizes! Click on the event above to register.

July 27th-30th and Aug 3rd-6th, join instructor, Ryan Fulcer, on an 8-day, Live In-
Person Brokers License Course at RANW! Register now and get ready to level up!

READY TO GET YOUR BROKER LICENSE!?

Grab your team, bring your competitive spirit, and join us for a fun-filled day of
kickball, food, prizes, and giving back! REGISTER HERE!

📅 Date: August 6th
⏰ Time: 12:00 PM – 5:00 PM
📍 Location: Riverview Park in Allouez

Team details:
Maximum of 12 teams - Teams of 8–10 players
Only one team member needs to be a RANW member
Kids are welcome - Spectators are welcome too!

RANW YPN KICKBALL FOR A CAUSE

Alpha Dogs serves walking tacos, hot dogs, brats,
hamburgers and pork macaroni and cheese bowls.

https://forms.office.com/pages/responsepage.aspx?id=zi5OJ796DkurZxus2J07lji_7vEwVq1Mqo4yhhWzzM9UNVVFWkxXNUg4TE5LUUtEODVRWVY1NzIxRC4u&route=shorturl
https://forms.office.com/pages/responsepage.aspx?id=zi5OJ796DkurZxus2J07lji_7vEwVq1Mqo4yhhWzzM9UQUlRRE5RT0hUWjZTNDJDUFc2Q1RVWUU5TS4u&route=shorturl
https://ranwwebsite.azurewebsites.net/events-education/ranw-events/oshkosh-lake-breeze-golf-course-outing/
https://www.zeffy.com/en-US/ticketing/wcr-summer-mastermind--2026
https://realestatelicenseacademy.com/brokers-license
https://bit.ly/4dxlZKD?fbclid=IwY2xjawRvCtlleHRuA2FlbQIxMABicmlkETFHVWIyUGdNQVRNMGpuYjFhc3J0YwZhcHBfaWQQMjIyMDM5MTc4ODIwMDg5MgABHsk8yv7zF92hHP3vCvKeD9gjAUHWtMwZfdqN5OaMkUKjaAjdZy1OWjTwLPPY_aem_rfQcSiT0O_39M9juuXDA6w


Membership
Membership Changes
To view RANW membership changes, click HERE.

MLS News

RANW NEW MEMBER PORTAL 

Member Anniversaries
Check our Anniversary chart for active members! You can search here by last name. All Active members
are all listed here! Happy Anniversary RANW all stars!

Many of you have already gone into the new member portal in order to pay MLS monthly
billing for companies. This new portal is also for individuals to login to change contact
information, pay annual REALTOR® dues, and eventually to sign up for events, education
and committees! Check out how to use our new member portal HERE!

Using FOREWARN is so
important to your safety as an
agent. RSVP today for the next
two webinars on June 9th and
June 25th. Learn about the
brand new feature, Household
Risk Lookup! FREE to RANW
MLS subscribers!

FOREWARN
TRAINING

NAR CONSUMER RESOURCES 

Navigating Mortgage Interest Rate Shifts
Financing a Renovation When You Buy
Staging your House for a Sale
Spotting Deepfake Scams in Real Estate
Are You Ready to Invest in Real Estate?

Consumer Guide: How Solar Impacts a Real Estate Transaction

Multiple Listing Services
Overcoming Roadblocks to a Sale or Purchase

Sign in to RPR today and click on the one-click RSVP button
that pops up on lower right.  If you're not familiar with RPR,
this is a FREE national database for REALTOR members! 

Check out what you can do with a 3d
virtual walk-thru with Cubicasa! 30

second video here!

https://ranwwebsite.azurewebsites.net/media/2741/2026-june-nl-membership-page-060826.pdf
https://member-anniversaries-chart.replit.app/
https://member-anniversaries-chart.replit.app/
https://ranwwebsite.azurewebsites.net/member-services/how-to-join-apply/how-to-use-your-ranw-member-portal/
https://www.forewarn.com/training-webinars/?utm_campaign=Training%20Webinars&utm_medium=email&_hsenc=p2ANqtz--0U1r26Ni-uH_8WYxne90t1q3rN0_tsUqb0OiV4vyzyccLeuRl_xf7P1nKUKa3LBCFvKE_-T7fLaLDHogPg_ROwAVYRQ&_hsmi=421860896&utm_content=421860896&utm_source=hs_email
https://www.nar.realtor/the-facts/consumer-guide-navigating-mortgage-interest-rate-shifts
https://www.nar.realtor/the-facts/consumer-guide-financing-a-renovation-when-you-buy
https://www.nar.realtor/the-facts/consumer-guide-staging-your-house-for-a-sale
https://www.nar.realtor/the-facts/consumer-guide-spotting-deepfake-scams-in-real-estate
https://www.nar.realtor/the-facts/consumer-guide-are-you-ready-to-invest-in-real-estate
https://www.nar.realtor/the-facts/consumer-guide-how-solar-impacts-a-real-estate-transaction?fbclid=IwY2xjawRsugtleHRuA2FlbQIxMABicmlkETFkUTJkU2JwWUdLT1NiWUMxc3J0YwZhcHBfaWQQMjIyMDM5MTc4ODIwMDg5MgABHlYgJwR3vy25faVPW0QlvehkBNQIQRrmVF_e8w05jXsMjtwfFePGmaGtYotb_aem_OdHcI-P67IsqKgrahgXitw
https://www.nar.realtor/the-facts/consumer-guide-multiple-listing-service-mls
https://www.nar.realtor/the-facts/consumer-guide-overcoming-roadblocks-to-a-sale-or-purchase
https://auth.narrpr.com/auth/sign-in?ReturnUrl=%2Fconnect%2Fauthorize%2Fcallback%3Fclient_id%3Dmain_website%26redirect_uri%3Dhttps%253A%252F%252Fwww.narrpr.com%252Fauth%252Fcallback%26response_type%3Dcode%26scope%3Dopenid%2520email%2520rpr_contact%2520rpr_current_user%2520rpr_permissions%2520rpr_roles%2520main_api_access%2520web_api_access%2520auth_api_access%26state%3D8904638b735e4e7c9bfb15ec245870dc%26code_challenge%3DIFI5vCB83RQHJdR3FKArp39-wPsNocMQjrmyNDjMw-U%26code_challenge_method%3DS256%26response_mode%3Dquery
https://youtu.be/lmyYBZ7iExA?si=CzSQ6GUQHXzEI0i3
https://youtu.be/lmyYBZ7iExA?si=CzSQ6GUQHXzEI0i3


Dearest Gentle REALTOR®,
It has come to this author’s attention that while summer often tempts society toward
leisure, lemonade, and long afternoons, a wise REALTOR® knows that June is also a most
excellent time for a mid-year polish.
As our nation prepares to approach its 250th anniversary, one cannot help but reflect
upon the importance of presentation. After all, declarations must be clear, signatures
must be legible, and one’s public presence must never appear neglected. The same, dear
reader, may be said of your professional digital estate.
Consider, if you will, the humble email signature. Does it still contain the correct phone
number, office information, designations, and links? Or has it quietly become a relic of a
prior season? And what of your online profiles, website biography, social media pages,
saved searches, templates, passwords, and client management systems? Are they
polished and current, or gathering dust like an unopened invitation?
This author would be remiss not to mention that clients often meet you long before they
meet you. They encounter your name in search results, your photograph on a profile,
your words in a message, and your professionalism in the smallest digital details. One
must never underestimate the impression made before the first handshake.
A mid-year technology tune-up need not be dramatic. Indeed, the most effective
refinements are often quite simple. Refresh your headshot if it no longer resembles the
current season. Review your voicemail greeting. Update your links. Clean up old
templates. Check that your forms, bios, and branding remain accurate. Strengthen
passwords where needed. Remove what no longer serves you. Organize what does.
There is, after all, a certain dignity in being prepared.
As the country nears a historic celebration of 250 years, let us remember that progress
has always favored those willing to adapt while honoring what matters most. In real
estate, that means pairing timeless service with modern tools, ensuring that every
REALTOR® remains not only knowledgeable, but accessible, professional, and prepared
for the next opportunity.
So before the summer season carries us too far into cookouts, closings, and calendar
chaos, take a few moments to inspect your digital presence. A well-kept professional
image is not vanity, dear REALTOR®. It is strategy.

Until our next correspondence,
Yours watchfully,

The Communications Committee

Communications

Communications Committee Confidential

Who wrote this
month’s column?



🤖 AI Prompt of the Month: Turn Local Summer Conversations Into Real Estate Content
Summer in Northeast Wisconsin is full of natural conversation starters: festivals, lake days, farmers markets,
youth sports, graduation parties, patios, road construction, neighborhood events, and “should we finally move
before school starts?” conversations.
This month’s prompt helps agents turn everyday local happenings into content that feels personal, useful, and
actually worth reading.
Instead of posting another generic market update, use AI to create content that connects real estate to real
life. Read the whole story HERE.

But Shiocton’s true heartbeat lies in its unstoppable grit and neighborly devotion. When rising waters
threatened the area during the April 2026 floods, the village didn’t flinch. Instead, residents instantly
mobilized to stack an unbelievable 60,000 sandbags, working shoulder-to-shoulder to safeguard their
hometown. It’s exactly this fierce, deep-rooted care for one another that defines the culture of the area and
makes it such a special place to live.

Walk down the Highway 54 corridor and you’ll immediately feel that local entrepreneurial energy. The
town is anchored by community pillars like Hometown Grill, packed daily for its monster omelets and
fresh scratch-baked bread. Right nearby, the town’s creative side shines at Studio 54, a brilliant hybrid
space combining a premium coffee bar, chic boutique, and full-service salon under one roof.
Meanwhile, Johnson’s Hardware & Appliance keeps everyday life running smoothly. Combined with the
sprawling trails and pristine wilderness at the Navarino Nature Center, Shiocton stands tall as a true
Northeast Wisconsin treasure.

AI / CHATGPT PROMPT OF THE MONTH

2-MINUTE TECH TIP... OR LESS!

HOME TOWN HIGHLIGHT — SHIOCTON, WI
Nestled 30 minutes west of Green Bay along the scenic banks of
the Wolf River, the village of Shiocton is proof that incredible things
come in small packages! Home to roughly 930 residents, this
vibrant community comes alive every spring for its legendary
walleye runs and the awe-inspiring lake sturgeon spawning at
Bamboo Bend. Onlookers gather from all over to witness these
armored, prehistoric giants thrashing along the shallow shores - a
spectacular natural phenomenon that serves as an annual point of
pride for the entire area.

CONVERT A PDF INTO EXCEL IN 1-MINUTE
With AI doing so much for us now, it’s kind of fun to learn an old
school Excel tip once in a while. This one takes less time than
asking AI to convert it for you! Import a PDF into your Excel file by
going to Data>Get Data>From File>PDF. Choose the PDF you want
to convert. Then the navigator will come up. Choose the table of
data from your PDF you’d like to convert, usually Page 001 (you can
choose multiple pages). Then you have a beautiful table of data just
like that! Click HERE for a 10 second video.

https://ranwwebsite.azurewebsites.net/media/2740/ai-prompt-of-the-month-june-2026-docx.pdf
https://www.facebook.com/reel/956433233437059
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